
VIPA reserves the right to make changes without prior notice to cater for technical developments.

Manual

WinNAT

Rev. 00/32



Contents VIPA WinNAT Manual

VIPA reserves the right to make changes without prior notice to cater for technical developments.

This manual is supplied as-is and without warranty. The contents of the manual may be changed at any time without
prior notice. The software described in this manual is subject to the conditions of a general license. In terms of this
license you may make copies of the software for the exclusive use in your company or place of business.
You will be held liable for any damages resulting from contraventions.

© Copyright 2000 VIPA, Gesellschaft für Visualisierung und Prozessautomatisierung mbH,
Ohmstraße 4, 91074 Herzogenaurach
Tel.: +49 (9132) 744 -0
Fax.: +49 (9132) 744 -144
EMail: info@vipa.de
http://www.vipa.de

Hotline: +49 (9132) 744 -114

All rights reserved

VIPA® is a registered trademark of VIPA Gesellschaft für Visualisierung und Prozessautomatisierung mbH

WINDOWS® is a registered trademark of Microsoft Corp.

WINDOWS 95® is a registered trademark of Microsoft Corp.

WINDOWS NT® is a registered trademark of Microsoft Corp.

All other trademarks mentioned in the text are the trademarks of the respective companies and are hereby acknowledged.



VIPA WinNAT Manual Contents

Rev. 00/32 i

Contents

Introduction 3
Welcome..............................................................................................................................3
Getting started......................................................................................................................3

Scope of delivery...................................................................................................3
System requirements .............................................................................................3
Installation of WinNAT.........................................................................................4
Registration and software release ..........................................................................4
Installing the driver................................................................................................5
Network setup........................................................................................................5
WinNAT directory structure..................................................................................6
Starting the program..............................................................................................6
Closing the program ..............................................................................................6

WinNAT Environment 7
Help system .........................................................................................................................7
Popup menu .........................................................................................................................7
Main window.......................................................................................................................8

Menu bar................................................................................................................8
Menu items of the main window ...........................................................................8

Print .....................................................................................................................................9
Print options ..........................................................................................................9

Network analyzer 10
General information on the network analyzer....................................................................10
Facilities provided by the network analyzer ......................................................................10
Network analyzer options ..................................................................................................10
Principle of operation ........................................................................................................11

WinNAT structure ...............................................................................................12
Recording...........................................................................................................................13

Recording messages ............................................................................................14
Stopping a recording session ...............................................................................14
Clearing a recording session................................................................................14
Long term recording ............................................................................................15

Analysis .............................................................................................................................16
Analyzing messages ............................................................................................17

Detailed analysis ................................................................................................................18
Parameter ...........................................................................................................................19

General ................................................................................................................19
Detail ...................................................................................................................20
ISO protocol ........................................................................................................21
Recording ............................................................................................................22

Filter...................................................................................................................................23
Stations (hardware filter) .....................................................................................23
Protocols (software filter)....................................................................................24
TPDU (software filter) ........................................................................................24
Addresses (software filter)...................................................................................25

Symbol-Manager ...............................................................................................................26
Overview of protocols .......................................................................................................28

Glossary 29

Index 31



Contents VIPA WinNAT Manual

ii Rev. 00/32



VIPA WinNAT Manual Introduction

Rev. 00/32 3

Introduction

Welcome
The WinNAT software is an Ethernet-based network analyzer.

The name WinNAT is an acronym for Windows Network-Analyzer-Tool. This analyzer is compatible with
Windows NT4. We hope you will enjoy working with WinNAT.

Getting started

Scope of delivery
The WinNAT program is delivered with the following components:

• WinNAT

• BDE (Borland Database Engine)

• WinNAT driver

• Manual

System requirements
The following hardware components are required for WinNAT:

• Original or IBM compatible PC that supports Windows NT

• 80486 processor or better

• 16 MB RAM, we recommend 64 MB

• Display resolution of 800x600 or better, 65536 colors

• Hard disk of 100 MB or larger.

• Windows NT4

• 1 unused slot for the network adapter
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Installation of WinNAT
WinNAT is installed by means of a setup program. WinNAT is a component of the VCL (VIPA Component
Library) and it can be installed as a component of the VCL-setups.

We strongly advise that you terminate all other Windows programs before installing WinNAT. Insert the
WinNAT-CD and start the program Setup.exe. The following procedure is executed:

• The setup assistant is initialized. You must select a language and confirm your selection with [OK]

• The Welcome window is displayed. This contains information on the installation and on the copyright
– confirm by clicking [Next] and indicate your agreement with the licensing conditions by means of
[Yes].

• Enter your name and the name of your company into User information.

• Select the WinNAT directory as the Path.

• All files of WinNAT and of the data collection system are copied to your PC.

• Registration and software release

Registration and software release
The version of WinNAT supplied to you is a 3-day demo version that can be enabled for full operation by
contacting VIPAs support, i.e. during the first 3 days you can use the unrestricted version for test purposes.
After 3 days certain WinNAT functions will be limited. They will be re-enabled when you register WinNAT
with VIPA.

For this purpose you must start WinNAT. A dialog box is displayed with a key word after the heading "Key":

Submit this key word (Key) along with your respective user name (Username) to the following address by
e-mail requesting a release code: support@vipa.de or you can phone the Hotline number shown above.

You will receive the required user name together with your registration number by return e-mail.

Start WinNAT and enter the "Username" and the "Registration-Number" into the dialog box and click on the
"Registration" button.

If all the entries were correct WinNAT will be started and all restrictions are removed.
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Installing the driver
A special driver is included with WinNAT. This driver contains all the functions required for communications

between WinNAT and a network adapter.

The driver is only compatible with WINDOWS-NT4. It must be installed via network environment icon
located in the control panel.

Right-click the network environment with the mouse and click on Properties. This opens a multi-page dialog
box. Select the Services tab and add the WinNAT driver that was supplied to you.

For this purpose you must click on the [Add] button. This opens the dialog box "Select Network Services".
Click on the [Have Disk] button and select directory path \NatDrv\WinNT on the CD-ROM drive.

In the list that is displayed you must now select "VIPA GmbH Network Analyzer" and the click the [OK]
button. This concludes the installation of the Network Analyzer service.

Click on the [OK] button and restart your computer.

Network setup
WinNAT requires that your computer be connected to an Ethernet network. You must have installed a

network adapter and informed your operating system of the new hardware component.

The current configuration for your network is accessible via the Network icon in the Control Panel. Add the
network component for the TCP/IP protocol if it does not exist. Click on "Properties" to assign an IP address
to the TCP/IP network component. The IP addresses of the computer used to perform the analysis and those of
the network nodes you wish to analyze must be located in the same segment of the network to allow
monitoring of the communication activity.

You can obtain the IP-address and other details required for the configuration of the network adapter you’re
your system administrator.
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WinNAT directory structure
The WinNAT directory is defined during the setup procedure. The following directory structure is created on
your hard disk during the installation.

Starting the program
The simplest method to start WinNAT is by opening the WINDOWS Start button and selecting WinNAT
located in "VIPA Component Library". You can also start the program by executing WinNAT.EXE directly.

You will be reminded to register WinNAT when you start the program if you have not registered previously.

The program starts by displaying the Start box, which contains information on the program version. The
optimum display settings for WinNAT are defined in the Control Panel by means of the "Display" icon. Select
Small Font and a resolution equal to or better than "800x600" pixel. You should also choose 65535 colors to be
able to distinguish the different images properly.

Closing the program
You can close WinNAT via the main menu. A file named WinNAT.ini is saved when you terminate WinNAT.
WinNAT.ini contains all the settings you have defined for the program.
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WinNAT Environment

Help system
WinNAT offers a variety of help functions. You can always access the help topics located in the main menu
under menu item ? when you are configuring WinNAT.

When you require help in the WinNAT window you can always press the function key F1 or the Help button.
This opens the context-sensitive Help window with the respective explanation.

If you access the help topics a help window is opened that provides an overview of the help topics sorted
according to categories pertaining to the respective program. You can reach the topic of your search by
clicking on the Book icon. One "Book" can contain other "books".

If you double-click the topic the help text of the selected topic is displayed. You can close an open book by
double-clicking the book.

If you are searching for an expression in the help items you can either enter the expression directly into the
dialog box or you can search the index.

For more information on the help system refer to the description of your Windows system or press F1 in your
Help window.

Popup menu
Since WinNAT was programmed in accordance with standard Windows conventions it also offers a popup
menu that is accessible by clicking the right mouse button.

This menu provides direct access to those functions that are only applicable to the current cursor position.

Depending on the cursor position you can use the context menu to:

• Define parameters

• Specify filters
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Main window
The main window is displayed when WinNAT has started. It contains the menu bar and the toolbar that
provide access to the most important functions.

Menu bar
The menu bar provides access to all available main functions. The menu bar is located at the top of the main
window. The following table shows an overview of the available menu items:

Menu Item

File Open/save a capture file, Print options, Exit

Edit Symbolism (symbol manager)

Extras German, English

Analyzer Network, Parameter, Filter

? Help topics, About, Registration

Menu items of the main window
Here follows a list of menu items with the respective buttons and a short description of the operation. Buttons
provide access to the most important functions.

File > Open capture file

Opens an existing file that contains the results of a previous analysis. A file selection window is displayed
where you can choose the file for the analysis.

Edit > Symbolism

The symbol manager is used to assign symbolic names to absolute addresses. These addresses may either be
Ethernet or IP addresses.

Analyzer > Recording window -Functions

This button transfers you to the recording window where you can start recording immediately.

Extras > German and/or Extras > English

Here you can select the required language without terminating the program. At present you can choose either
German (Deutsch) or English.
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Print
You can use the print function to document your settings or to troubleshoot the settings you have defined.
Every WinNAT window has a Print button. This provides various options for printing the recorded data. You
can also print a certain number of frames.

Print options
You can define the printer settings by means of the Print options. When you select File > Print options the
"Print options" dialog box is displayed.

Project, Name, Firm,

Here you can specify optional entries that will appear in the footer of the printout.
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Network analyzer

General information on the network analyzer
The network analyzer for Windows NT is a networking, analysis and documentation tool for Ethernet
networks. When WinNAT is used in conjunction with a network adapter it provides a user-friendly
environment that is based on the Windows NT operating system.

Facilities provided by the network analyzer
• Summary of those activities that are currently active on the network.

• Recording of historical data on the network activities over a specific period of time.

• Long term recording

• List of stations that are active on the network.

• Summary of stations that are currently communicating and what data is being exchanged.

• Messages of individual recording sessions are presented in list form together with a short description.

• Individual messages can be displayed in detail via a plain text window.

• You can use your computer while recording is taking place.

• You can use hardware (recording filters) and software filters.

• The product provides decoding facilities for the ISO-TP4 protocol (Siemens SINEC H1) and TCP/IP.

Network analyzer options
• All settings are saved automatically.

• Messages can be displayed and printed with different levels of detail.

• Recording sessions can be saved and restored from hard disk.

• You can assign symbolic names for addresses by means of the symbol manager.

• You can use hardware-related filters for recording sessions.

• Various software filters can be used for displaying the data.

• The size of the recording buffer is variable.
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Principle of operation
All the traffic on the network is available on the network adapter since this is connected to the local area
network. The driver for the network adapter transfers the information into the protocol driver. This is where the
recording filters accept only the data from those stations that have been selected in the filter. This data is saved
in a ring buffer. The originator and the recipient of the message are determined when the data is entered into
the buffer. This is then used to generate the recording.

Once recording has been stopped the recorded data of the stations can be analyzed. You can activate the
display filter (software filter) when you view the recording. The analysis of messages displays these in
chronological sequence.

You can page through the analysis list by means of the page and the arrow keys or by means of the mouse.

A single analysis procedure consists of three stages: recording → analysis → detailed analysis

Recording is always started on the recording level. Recording includes all the stations that participate in the
communications on the network and these are then displayed in the recording. You can then use this list for
analysis purposes or to perform a detailed analysis.

The following flow charts illustrate this procedure:

[Start]

Activate
long term
recording?

Apply
hardwarefilter

[Stop] ?

Recording

Apply
softwarefilter

Analysis

Detail

Long term
recording file

Capture file

Long term
recording file
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WinNAT structure
This flow chart contains an explanation of the different sections. You can also see which areas are affected by
filters and parameters.
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Recording
The recording window contains a list of all the station pairs and statistics on the rate of traffic in your network.

Recording is started when you click on the [Start] button. This is displayed by means of an indicator on the
[Start/Stop] button. If the network adapter is connected to a working network the display will immediately
show all the stations communicating with each other. The station list can be cleared at any time by clicking on
the [Clear] button. When you have cleared the list any active recording resumes immediately with up to date
station names. If you have activated symbolic addressing the station names are displayed in symbolic form.
You cannot activate an analysis of messages while recording is in progress.

When you have stopped recording you can analyze the recording. You can select one or more pairs of stations
for an analysis of the data in the recording. If you do not specify a selection the analysis includes all the station
pairs. Station pairs are selected in the column Sel. The analysis of the messages is started by clicking on the
button [Analyse].

The [Print] function creates a printout of the recording.

Column heading:

Sel the column Sel is used to select a station pair after recording has completed

Station A Ethernet address of the destination station that was the first station to receive messages
after recording was started

Station B Ethernet address of the source station that was the first to start sending messages after
recording was started

Typ Type of protocol (see protocol summary on page 16)

Frame A->B Number of frames transferred from station A to station B

Frame A<-B Number of frames transferred from station B to station A

Byte A->B Number of bytes of all the frames that were transferred from station A to station B

Byte A<-B Number of bytes of all the frames that were transferred from station B to station A

Statistic:

Pairs Number of pairs detected during the recording session

Frames Number of frames recorded and analyzed
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Kbytes The size of all the frames in Kbytes

Used The usage of memory for recording in percent

Bdcast Number of broadcast messages that were detected

FPS Frames per second

Peak Peak value of frames per second

Buffer Number of received frames

Buttons:

Start Start recording

Clear Clear a recording session

Analyse Analyze a recorded session

Print Print the recorded stations

Recording messages
The [Start] button clears the recording and starts a new recording session. The [Start] button is provided with a
LED indicator that shows whether the network analyzer is recording or not. Messages are transferred from the
network adapter into the recording buffer for display in the recording list.

Stopping a recording session
The recording session is stopped by clicking on the [Stop] button. It is necessary to stop recording when:

• You want to analyze a recorded session

• You wish to save the data

• You want to change parameters and to activate filters.

Clearing a recording session
The recording is cleared by clicking on the [Clear] button. You can clear the recording buffer at any time. No
verification is required for this action.

Any previous recording sessions are cleared by a new start.
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Long term recording
You can activate a long term recording session by selecting "Long term recording" in the "Recording" tab
located in Analyzer > Parameter. Here you can also specify target directory for your recording. If you do not
define this directory the data is saved sequentially in the directory "WinNAT\Rec" as Record0.rec,
Record1.rec, Record2.rec ...

The file size of the individual recording files is determined by the "Buffer size" you have specified via
Analyzer>Parameter in the "General" tab.

Pay special attention to the parameters that you must define under Parameter Recording.

You start long-term recording session by means of the [Start] button in the recording window. As for the
normal recording phase, all the station pairs will be displayed in the recording window. The long-term
recording phase is stopped as soon as you click on [Stop]. When you click the [Analyse] button another
recording window is opened containing a list of the long-term recording files:

When you select a file and click the [Load] button the analysis window is opened and the messages of the
selected recording session are displayed.

Column heading

Sel the column Sel is used to select a capture file for analysis

Frames Number of frames in the capture file

Start Start recording to this capture file

End End recording to this capture file

Recorded file name Sequential name of the capture file during long term recording

Buttons:

Load The data of the file that you have selected is loaded for display in the analysis
window. You can only load one file at a time.
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Analysis
It is a requirement for an analysis that recording has taken place. A completed recording session can be saved
to a file or loaded from a file.

Click the [Detail] button to display detailed information about a specific message. The detail window is
displayed showing the selected message together with all the logical components and the different layer of the
message.

Column heading

Source The source station where the message originated

Destination The destination station that has received the message

Time-Stamp A time stamp

Length The length of the message

Typ The type of protocol (can change for a pair of stations)

Parameter The most important parameters are:
TP4: (D=Destination-Reference, YR-TU=next TPDU-Nr, CDT=Credit)
TCP/UDP/ARP/RARP: (SP=Source-Port, DP=Destination-Port and Flags)

Buttons:

Detail A detailed analysis of a message

Load Load a previously saved file with analysis data

Save Save analysis data to a file

Print Printout of the analyzed message data
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Analyzing messages
All the messages in the analysis window are listed in the sequence in which they occurred. In contrast to the
recording in list form you can determine the time when a station transmitted or received data. The list also
contains an indication of the length of the messages and possible parameters.

All types of protocol are recorded and displayed.

At the moment the following protocols are analyzed; the analysis of additional protocols is under development:

• ISO-TP4 (H1) Transport TP4, ARP, RARP, IP (TCP, UDP)

• TCP/IP 802.2 ARP, RARP, IP (TCP, UDP)

• TCP/IP Ethernet ARP, RARP, IP (TCP, UDP)

802.2 – ISO TP4:

Transport-TP4 messages have one of the following TPDU-types. These are used to establish the connection,
for flow control purposes or to transport the data.

ISO TP4 messages are assigned to layer 4 of the ISO/OSI layer model.

CR (Connect Request) To establish a connection

DR (Disconnect Request) Issued by the station to terminate a connection

CC (Connect Confirm) Returned by the station that received a CR

DC (Disconnect Confirm) Transmitted by the station that has received a DR

AK (Acknowledges) Used for flow control and confirms data was received correctly

EA (Expedited Acknowledges) Used for flow control and confirms correct reception of expedited data

DT (Data) This is used to transmit user data

ED (Expedited Data) This TPDU transmits expedited data

RJ (Reject) Issued to request a repeat when messages have been lost

ER (Error) Message containing the reason for the reject

DG (Datagram) Datagram service

TCP/IP 802.2 or in accordance with the Ethernet spec.:

TCP/IP-messages comprise a.o. TCP, UDP, ARP and RARP. These messages are assigned to layer 3 and 4 of
the ISO/OSI or the TCP/IP layer model.

TCP (Transmission-Control-Protocol)

UDP (User-Datagram-Protocol)

ARP (Address Resolution Protocol)

RARP (Reverse Address Resolution Protocol)

NETWARE, NETBEUI, NETBIOS these messages are not analyzed at present.
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Detailed analysis
You can select a specific message from the list displayed in analysis window. When you click on the [Detail]
button the "Detail"-window is opened showing the logical parts of the message and the different layers of the
telegram.

In this case a direct relationship is provided in hexadecimal form between the contents of the telegram and the
respective plain text significance.

Message
from analysis
window

Message
contents with
layer analysis

Message
contents in
hex and ASCII

The dialog box consists of 3 sections:

Message from analysis window

In this section of the window you can scroll through the list of messages.

Message contents with layer analysis

This section displays a description of the separate message fragments. Every fragment of a message that could
be recognized is described in a separate line. You can quickly locate the description of the different bytes in the
message by means of the line that the cursor is located on since this is shown with a direct relationship to the
hexadecimal display. The different layers of a message are displayed in different colors and provided with a
name at the beginning of each line that is suitable for the layer.

• MAC Layer 1 Media Access Control

• DLC/LLC Layer 2 Datalink Control-Header / Local Control/Header

• ISO CLNP Layer 3 Connectionless Network Protocol

• ISO TP Layer 4 Transport Layer Protocol

• ISO SESS Layer 5 Connection-oriented Session Protocol

• ISO API Layer 7 S5 AP-Header, TF, FMS

For messages that are not analyzed any further only the MAC layer is displayed.

Message in the hexadecimal display section

This section displays all types of message in hexadecimal representation. The different fragments of the
message are displayed in different colors with relationship to the plain text.
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Parameter
Parameter provides access to the different settings for WinNAT. The respective parameters are accessible via
Analyzer > Parameter on the main menu or in the WinNAT windows by means of the right mouse button.

At present you can change the following parameters via 4 tabs:

• General (parameters for the recording operation)

• Detail (display format for time and address)

• ISO protocol (define TPDU format)

• Recording (define parameters for long term recording)

General
In this tab you can specify the general settings for the recording process and to determine the load on the local
computer.

Frame size The maximum message size in bytes that will be recorded.

Buffer size The size of the recording buffer in Megabytes

Frames/Cycle Maximum number of frames that can be retrieved in one cycle from the
driver.

Cycle time The duration of a cycle in milliseconds. This determines the frequency
with which message data that is provided by the NAT driver is retrieved. If
this time is high the data quantity retrieved per cycle is also high
(maximum see Frames/Cycle).

The NAT-Driver requests a data area that is equal in size to the buffer size setting and
that cannot be relocated.
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Detail
Detail refers to the format with which addresses and time stamps are displayed in the analysis window.

Address TCP/IP messages can be displayed with the Ethernet address or the IP
address. However, the IP address is only displayed when the message is
analyzed and not during the recording phase.

Tome format At present only the absolute format is supported.

Other formats are under development.
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ISO protocol
Various TPDU formats can be used for an ISO-TP4 (H1) message. These are divided into normal and
extended classes. Over and above this the classes are also differentiated by means of sequential
numbers.

The exact format of a TP4 message can only be determined when the connection is being established.
However, since the connect procedure was not necessarily recorded, the format may be
indeterminable. You may safely assume that TP4 (H1) messages originating at a CP always have the
"extended format class 2, 3, 4" (default).

TPDU-Format This selector determines the interpretation of the TPDU format. The
default is the interpretation of the extended format for classes 2,3,4... .
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Recording
Enter the parameters required for long-term recording on the recording tab.

Destination directory Enter the path name where you want to save the capture file that is used
for long-term recording.

Max. Capacity Enter the maximum capacity that you wish to make available for long term
recording sessions.

Ring buffer Here you determine whether long-term recording should take place via a
ring buffer consisting of capture files or if it should continue until the
absolute limit of recording capacity is reached.
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Filter
You can access filter functions on the main menu via Analyzer > Filter or in the respective window by means
of the right mouse button.

In the filter tab you can define the filter conditions that apply to the recording of data required for the following
analysis.

The recording filters (hardware filter) prevent certain messages from being saved on file whilst the display
filter (software filter) selects certain messages from the total that was recorded. If you deactivate the display
filter a new analysis will again include all messages.

Every dialog page contains the check box Filter active that enables or disables the filter function for the current
page.

The status of the filters is included for your information, i.e. if the hardware filter was activated in the
recording window "Hardware filter active" and if the software filter was activated in the analysis window
"Software filter active".

Stations (hardware filter)
The Stations filter is a recording filter. Here you must always enter the 12-digit Ethernet address.

Only stations appearing on list A and/or list B are recorded. A maximum of 10 stations each can be
accommodated in the list.

If you wish to enter a station address you must select a list element and enter the respective Ethernet address. If
you have activated the symbolism you can select a symbolic name in the selection filed which is transferred
into the list.

To delete an element you must first select the element on the list and then press the Del.-key.

Direction Determines the recording direction for all the entries in the list

Every station You may select station by entering the respective addresses into a list or
you may select "Every station". This corresponds to entering all stations
into the list.
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Protocols (software filter)
The Protocols filter is a display filter for the selection of the required protocol.

One or more protocols can be transferred from the list of available protocols into the list of protocols that was
selected. You can transfer or reverse a transfer by selecting the respective entry in the list and pressing the
transfer button [>>] or the reverse button [<<].

TPDU (software filter)
The TPDU filter is a display filter used for the TPDU- selection of H1-messages. One or more TPDU-types
can be selected.
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Addresses (software filter)
The Addresses/Ports filter is a display filter that selects messages by means of the address and the port. Only
those messages that contain the address and/or the port specified in the filter are displayed.

MAC-
Source/Destination

Enter the required Ethernet address (MAC-address) into source and/or
destination.

If you should enter an incomplete address the filter will use this fragment
for the filtering operation.

Src/Dest Reference The source- and destination reference are numeric values that are
associated with the respective TSAP. These are determined at the time
when the connection is established between the stations.

TCP/IP-
Source/Destination

Enter an IP address into source and/or destination.

Source/Destination/
Alternative Port

Port corresponds to the port no. of a TCP/IP connection. You can specify
an additional port no. under Alternative Port that is used instead of the
source/destination port if required.

If you should choose to activate this function the directions (source and
destination) are ignored.

Und/Or function The And function specifies that only those messages are displayed that
meet all the specified conditions. For the Or function only one or more of
the specified conditions is required.
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Symbol-Manager

Symbolic addressing
Symbolic addressing provides you with the option to assign symbolic names to Ethernet addresses and to IP-
addresses. Names are not subject to any conventions. The only restriction is a limit on the length of the names,
since these are truncated after 20 characters by different routines, e.g. the documentation function.

If you have enabled symbolic addressing the symbolic names will be displayed in all the locations where
absolute addresses would otherwise be used. The symbolic names are also available for the selection and input
fields.

Duplicate names for Ethernet addresses and/or IP-addresses are located and displayed during the compilation.
These can be sorted in accordance with the absolute address or the symbolic name. You can request that the
display is sorted in accordance with absolute addresses or according to the symbolic name. If you do not want
the result sorted you select none.

Symbol manager functions
The different functions will be described in detail:
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Symbolic display

If you have selected symbolic display, the symbolic address assigned to every absolute address appears in all
routines. The commentary appears only in the symbol management.

Sorting

You may choose to use Absolute or Symbolic sorting or you may disable sorting by selecting None.

Buttons:

OK When you press the [OK] button the lists are examined and a reference window
is displayed if you should have entered invalid and/or duplicate symbolic names.
If you press [Abort] all changes the addresses that were entered automatically are
lost.

Load, Backup When the program starts the most recent list of symbols is loaded. It may be
necessary, however, to save the list of symbols in a file. You can save a list of
symbols to a file by means of the [Backup] button and/or load a list of symbols
from a previously saved file by means of the [Load] button.

Ping You can use the Ping function to check whether a destination module is available
on the physical network.

For this purpose you must place the focus on the required IP-address in the
symbol table.

The Ping transmits an ICMP-message to the destination module. The respective
module returns an answer within a certain reaction time. The result is displayed
in text form.

If the Ping was successful the message "Ping-Echo" in n ms is displayed,
otherwise the display contains an error message.

Delete All If you click [All] the entire set of entries is deleted after you have been requested
to confirm this.

Delete Line You can delete the line where your cursor is located by pressing Ctrl-Del.

Insert Line You can insert a blank line above the current selection by pressing Ctrl-Ins.

The numbers displayed in the bottom border of the lists provide information on
the current cursor position Line : Column. This is also included in the error
messages.
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Overview of protocols
All types of protocol are accepted, however, the analysis currently only includes the following protocols:

Ethernet-TCP/IP ARP, RARP, IP (TCP, UDP)

802.2 – ISO Transport TP4, ARP, RARP, IP (TCP, UDP)

Transport

TP4

S5/TF/FMS

UDPTCP

802.2
1

2

3

4

5

6

7

LAYER
TCP/IP ISO

Network-Protokoll

Ethernet

802.2

(Applikationsschicht = Application layer)

S5 - Read Write
TF - Technologische

Funktionen
FMS- File Message

Specification

ARP RARP IP

Ethernet
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Glossary

AP

Application Protocol

AS

Automation System

BCD

Binary-Coded Decimal number

CP

Communication-Processor (H1 and TCP/IP)

DNS

Domain Name System

GSD

Gerätestammdatei (master device file)

HTB

Handler block

IP

Internet Protocol

IPK

Intelligent Process communications

ISO

International Organization for Standardization

LAN

Local Area Network

Layer

A layer in the ISO/OSI-layer-model (1 to 7)
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MMS

Manufacturing Message Specification

NAT

Network Analyzer driver

OSI

Open Systems Interconnection

PDU

Process Data Unit

QVZ

Quittungsverzug (delayed acknowledgment)

SNMP

Simple Network Management Protocol

TCP

Transport Control Protocol

TP

Transport-Protocol

TPDU

Transport Protocol Data Unit

TRADA

Transparenter Datenaustausch (transparent data exchange)

TSAP

Transport Service Access Point

UDP

User Datagram Protocol

VDE

Database Engine, for the administration of the database
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P
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Ping 27
Print options 9
Printer output 9
Protocols 17

Overview 28

R
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S
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